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ComicBase Express User Guide Getting Started

Welcome to  
ComicBase Express!

Thank you for purchasing ComicBase Express. The new ComicBase Express 
lets you easily track the essentials of your collection with a built-in database 
of over 275,000 listed comics, current prices for each issue, over 5,000 
full-color cover images, and free, downloadable, weekly content updates!

ComicBase Express will give you information on what each title is about, 
tell you how it relates to other titles, and help you keep track of what 
comics you have in your collecrtion. You can use ComicBase Express to 
generate title reports, collection statistics, create price labels, or print issue 
checklists.  

We’ve combined our research with that of Comics Buyer’s Guide to cover 
over 20,000 comic titles, from indie releases to major publishers like 
DC and Marvel, with new titles and issues added every week as they are 
released.

What You Should Know  
Before Using This Guide
This user’s guide assumes you know the basics of using your computer. For 
example, you should know how to:

• Use the mouse and keyboard

• Know how to click and drag with your mouse

• Choose from a menu

• Copy files and disks

If you are unsure how to perform these tasks, consult the User’s Guide 
which came with your computer. 

Installing ComicBase Express
1.	 Exit any Windows programs you are running. This is important: 

running programs can prevent ComicBase Express from 
installing properly.

2.	 Insert the ComicBase Express Program Disk into your CD-
ROM drive. The ComicBase Express launcher program will start 
automatically (double-click the Launcher.exe file if autostart is 
disabled on your computer).

A Primer on ComicBase 
Terminology

The following is a list of key words 
used in this manual.

Title is the name of a comic book se-
ries. Action Comics is a title. Within 
this title, there have been over 800 
issues.

Issue is a single installment of a title, 
usually with its own number. Exam-
ples are Action Comics #23 or The 
Amazing Spider-Man #42.

Comic is a generic term for a comic 
book. For instance, if you have two 
copies of The Amazing Spider-Man 
#42, and one copy of Bone #1, you 
have three comics.

Indicia is the name of the para-
graph containing the copyright and  
publication information of a comic. 
The indicia  is usually located on the 
inside front or back cover of a comic. 
It is also where the title’s real name 
is listed.

Cost is the price you paid for comic.

Value is what our research says is the 
current market value for an issue in a 
certain condition.

Price is the amount you wish to sell 
an issue for.
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3.	 The InstallShield Wizard will guide you through the installation 
process.

4.	 Install Adobe Reader (used for viewing documentation).

5.	 After the program has installed, launch ComicBase Express by 
double-clicking the icon on your desktop, or choosing it from 
your Start Menu. 

    The first time you run ComicBase Express, it will ask if you’re 
upgrading from a previous version. If you are, click Yes, then 
follow the instructions onscreen to transfer your collection data 
from your old version of ComicBase.

Launching ComicBase Express
When you first launch ComicBase Express, you will be asked to enter your 
name, your company’s name (if applicable), and the unique serial number 
for your copy of ComicBase Express. You will find your serial number inside 
the ComicBase Express case and on your registration card. 

Registering Your Program 
Register your copy of ComicBase Express by using the Internet menu’s 
Register ComicBase Online command or sending in the registration card 
which came with ComicBase Express.

You must register your copy of ComicBase Express in order to be eligible 
for technical support, upgrades, and other benefits!

Technical Support
Many questions about how to use ComicBase Express are already covered 
in this manual. Additional program updates and bug fixes are also 
available for free online. Your purchase of ComicBase Express includes 12 
free months of online program and pricing updates starting from when 
you first activate the program. You can download both the program and 
pricing automatically by using the Internet menu’s Check for Updates 
command.

If you have any questions that are not answered in this manual, a 
problem that cannot be solved by the latest update, or if you have 
suggestions for improvements/changes that you’d like to see in 
ComicBase Express, you can contact us at any time via e-mail to:  
support@human-computing.com. When contacting technical support, 
please include your registration number and a detailed description of the 
problem for the quickest  possible assistance.
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THe basics

The following few pages will cover everything you need to know to get 
started with ComicBase Express, including how to move between titles, 
look up prices and issue details, find special comics, and more.

In the next section, we’ll get into detail about how to navigate around 
and track your own collection in ComicBase Express. For now, let’s take 
a moment, and get familiar with the main ComicBase Express window: 
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1. 	 Cover Thumbnail	

Shows a thumbnail preview of the selected comic’s cover. If 
no image is available, then a publisher or default logo will 
be displayed instead. You can also drag and drop pictures 
from Windows to this thumbnail and ComicBase Express will 
automatically place your picture into this title’s picture folder. 
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2. 	 Title Genres

Displays icons designating the genres (e.g. Horror, Comedy) that this 
title features. (A full list of ComicBase genres and definitions begins 
on page 24.)

3. 	T itle Abbreviation 

Abbreviated title name assigned by ComicBase.

4. 	P ublisher Name & Years Published

Name of the publisher and the years during which this title was 
published. 

5.	 Current Title

	 Displays the full name of the series you are viewing. Right-click over 
the title to display options to print divider labels for this title, or search 
for this title online.

6. 	F ind Comics	

Allows you to search for comics by various criteria. You can use this 
function to quickly find comics by the cover date, artists, writers, 
storyline, or a publisher name that you’ve entered in the Issue Fields. 
See Finding Comics for a detailed description of of each search 
category.

7.	T itle List and Navigation Buttons

The Title List allows you to go quickly to any title in the database. 
Click on the file folder icon to bring up the Title List. Titles are listed 
alphabetically. You can begin by typing in the name of a title or by 
using the scroll bar to go up and down the list. 

To view the next title in alphabetical order, click the arrow pointing 
right. To view the previous title, click the arrow pointing left. Right-
click over either button to bring up additional navigational options. 

9. 	T itle Description

A brief write-up telling you what this title is about.

10. For Sale

Indicates that you may want to sell this comic in the future.

11. 	Minimum Quantity Retained

If you have issues of comics that you want to sell, this field tracks the 
number of copies that you want to keep for your own use. For example, 
set this field to “1” if you only want to sell your duplicates.

12.	I ssue Number, Issue Condition, Cover Price, & Other Fields

These fields show the issue number of a comic as well as quantity 
in stock, information about special appearances, cover price, dates, 
barcodes, etc. Blue text indicates a drop in the value of the comic 
while red text indicates that the selling value of a comic has increased. 
Black text indicates that a comic’s value has remained unchanged.

You can edit any cell in the issue field by double-clicking on the 
specific cell you want to change. Right-click on any field to bring up a 
list of options for managing your individual comics, such adding a new 
issue, deleting an issue you don’t want, or using the internet to search 
for copies of that issue. You can also acces these commands from the 
Comics menu.



ComicBase Express ComicBase Basics

�

You can drag the column headers either left or right to change the 
order of the columns. You can also resize a column or even shrink and 
hide it by dragging the column dividers left or right. (Right-click and 
choose Show Hidden Columns to unhide.)

13. 	Mark Issue Column

Use this column to note comics that are special to you in some way—
e.g. they have sentimental value, or you want to remind yourself to 
purchase them. 

(Note: marking an issue does not indicate that you own it—to do that, 
change the number of the quantity in stock to the number that you 
own.)

14. 	Cover Picture Icon 		

Shows whether or not a cover picture is available for this issue. Small 
image icons are red and blue, while high-definition, large image icons 
have a green plus sign over the icon. Holding the mouse briefly over 
the picture icon will automatically display the image. If a larger picture 
is available, pausing longer will zoom it to full size.

15. 	Issue Selection Column

Click in this column to select issues. Information on the first issue 
selected will be brought up and displayed. (Select discontiguous issues 
by holding down the Ctrl key while clicking on all the issues you wish 
to select. You can also hold down Shift while clicking to highlight all 
comics within a range.)

Titles
Titles in ComicBase are listed by alphabetical order and can be accessed 
through the Title List, or by using the navigation buttons on the top right 
of the main window. The fastest way to find titles is to type in the first few 
letters of the name of the title into the Title List. 

If you are having trouble finding a series you want, try typing in just the 
main part of the title name. Titles that start with “A” or “The” are indexed 
with the article at the end of the title. (Thus, The Amazing Spider-Man is 
actually listed as “Amazing Spider-Man, The”)

If you still can’t find the title you want, try a Find search. Just click on the 
ellipses (“…”) button above the scroll bar to start searching for the title.

Small	         Large

Did you Know…?

The Title List in ComicBase is not 
case-sensitive. It will find the correct 
title you whether you use in the cor-
rect capitalization and punctuation 
or not. 
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Finding Comics
The Find command can be used to search for titles or issues of comics 
matching various criteria. This can range from all the titles with “spider” 
in the name, or issues in your collection worth more than $50. It also 
has several special searches that allow you to locate a character’s first 
appearance, death, origin stories, and more.

To find issues, click on the Find icon in your ComicBase Express main 
window (the one that looks like the magnifying glass). You can restrict any 
search to just the titles you own by checking the List Only Issues in Stock 
checkbox at the bottom.

Using Find

Select the category you want from the Find dropdown list. The selections 
are divided into Title Name, Special notes, Title Fields, and information 
available from the Issue Fields.

Many searches will show an indexed list, which you can move through 
by quickly typing the first few letters of your search. For instance, if you’re 
looking for the first appearance of Psylocke, you may only have to type 
“psyl” in the 1st Appearance find box.

Click on the Find button to start the search. When ComicBase finds the 
items that match what you’re looking for, it will bring up a list of those items. 
The list will remain onscreen until you close it, so you can view other issues 
or titles that matched your search criteria. 

 Tip

Hot Key Shortcuts

Use these buttons on your key-
board to navigate your way 
quickly in ComicBase!

Ctrl + T	 Title List

Ctrl + ]		 Next Title

Ctrl + [		 Previous Title    
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Search Categories

The following is a list of all the search categories in ComicBase Express.

The first category available is the Title Name search. You can choose to 
search for a title by the exact name or by any word within its name.

Next, you can choose to search by Special Fields. These include: 

• 	 First appearance finds the first time a character appeared in any 
title.

• 	 Second appearance finds the second time a character appeared 
in any title.

• 	 Death finds stories in which a character dies. (Whether he/she/
it remained dead is another matter…)

• 	 Origin finds stories which tell how super-heroes (or villains) 
came by their powers, or found their calling. Origin stories are 
often repeated for popular characters, and sometimes revised 
for long-running characters.

• 	 Special Appearance will look for notable guest appearances by 
a particular character.

The third set of categories search for information under the Title fields. 
These are:

• 	 Comments let you find by title comments from the Title Detail 
dialog.

• 	 Custom Check boxes finds titles which have the Custom check 
box checked.

• 	 Date Created finds titles by the date they were added to your 
ComicBase. This search is particularly useful if you’re adding 
titles and want a list of the titles you’ve recently added.

• 	 Date Modified finds titles by the date they were modified. 

• 	 Description finds a title by words in its description, such as 
“vampire” or “spoof.”

• 	 Description Date Modified finds titles by the date you changed 
(or created) the titles’ descriptions.

• 	 Genre finds titles by which genre have been checked in the Title 
Detail dialog. If you check more than one genre checkbox, this 
search will only find titles that also have all those checkboxes 
checked. You can also search on custom genres you’ve 
created. 

• 	 Marked finds titles which have the Mark box checked. This 
refers to the default Mark box in the Title Information dialog 
and should not be confused with the Custom check boxes also 
in the Title Information dialog.

• 	 Mature Readers Only finds any titles that have the Mature 
Readers Only checkbox checked. 

• 	 Publisher helps you find all the titles from a certain publisher.

• 	 Years Published looks for titles based on their publication year. 
You can select a specific year or a range of years to search for.
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The next group of searches finds items based on Issue information.

• 	 Artist finds the issues which were drawn by a particular artist.

•  Condition finds comics by the condition they’re in, such as all 
your comics in very fine (VF) condition.

•  Cost finds comics in your collection by your cost, such as all 	
comics you bought for less than $1 each.

•  Cover Date finds comics by their cover date. Since some titles, 
like 2000 A.D., are published weekly, we use a month/day/year 
format. For instance, you can use it to create a list of issues 
published in March 1999 by entering 3/1/1999. Note that not 
every issue in ComicBase has cover date filled; you may need 
to add this information yourself.

• 	 Cover Price finds comics by their original cover price. For 
instance, you can use it to find all the comics you own which 
had a 75¢ cover price. Note: ComicBase does not include cover 
price for every issue—you may need to add this information 
yourself.

•  	Current Value finds comics in your collection by their current 
value—for instance, all comics worth more than $100 each.

•  	Date Modified lets you search for comic issues by the date they 
were modified in your ComicBase. For instance, you could 
use this to find a list of all the comics you logged into your 
collection yesterday.

•  	For Sale looks for issues with the For Sale box checked in the 
Issue Fields.

•  	Marked lets you find any issues with the Mark box checked.

•  	Minimum Quantity (to keep in your inventory) looks for comics 
that have minimum quantities you’ve designated to keep.

• 	 Notes searches the notes field for anything else that might be 
special about an issue, such as a costume change, a wedding, 
or information you’ve added, such as place where you bought 
it. When entering what you’re looking for, be as general as 
possible. For instance, if you’re looking for the issue in which 
Spider-Man donned a new costume, type in “costume” or “new 
costume.”

•  	Price finds comics in your collection by your selling price, such 
as all comics priced more than $50 each.

• 	 Quantity in Stock finds issues in your collection by how many 
copies you have. For instance, if you want to find all the issues 
for which you own more than 2 copies, so you can sell off your 
overstock, you can use this search.

• 	 Storyline finds issues based on the name of the story arc. It’s 
particularly useful for finding crossover stories that run through 
several issues and, sometimes, through several titles.

• 	 Writer finds issues which were written by a certain writer.
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Using Multiple Searches
If you’re looking for a comic that falls into more than one category, say, 
because you’re trying to hunt down a particular issue from a certain time 
period and publisher, you may need to do multiple searches to find what 
you want.

Click the Find button again while the Found Comics list is still onscreen. 
The second Find dialog box will now contain extra options to narrow or 
widen your previous search results. This allows you to do complex search-
es, such as finding “All the Marvel Comics published after 1953 and before 
1960.” To narrow searches, just select the Narrow Results option. To widen 
searches, choose Append to Results in the Find dialog box.

Note that some searches (such as searching for a Publisher) will bring back 
a list of titles; others (such as searching for Quantity in Stock) bring back 
lists of issues. ComicBase Express will automatically do the right thing in 
this regard without requiring you to explicitly choose the table. 

Occasionally, however, you may want to do a complex search which in-
volves both title fields and issue fields. The type of data in the list will al-
ways correspond to the last type of search chosen. For instance, if you want 
to see a list of issues from Dark Horse comics which you have more than 
one of copy of, first search by “Publisher is Dark Horse”, followed by a 
narrowing search for “Quantity in Stock is greater than 1.” If you wanted to 
see a list of titles from Dark Horse for which you have more than one copy, 
do the Quantity in stock search first, followed by the Publisher search. 
 

Hypertext Links
Move between related titles and learn more about the world of comic 
books with ComicBase’s hypertext links. If you click on any highlighted 
word in a ComicBase description, the program will take you to the related 
title. For example, in the description for Wolverine, the words “Uncanny 
X-Men” are highlighted in blue. When you click on the highlighted text, 
ComicBase Express will algorithmically find the matching title. 

internet Links
Various features in ComicBase Express also connect you to comic 
information on the web. To make use of these features, you have to be 
properly configured for internet access. See the instructions that came with 
your computer for help in doing this.

Right-click on the name to link to the publisher’s web page. If there is no 
link for a publisher, but you know the publisher’s URL, you can create an 
internet link for it using the Setup menu’s Publishers command. 

The Internet menu also has links to the ComicBase home page, the online 
registration form, and the ComicBase Express updates page. Remember, 
you must register your copy in order to receive technical support, advanced 
notice of upgrades, and special prices on upgrades!

You can also use commands in the Internet menu to shop for comics on 
online auction sites, or to research a comic’s recent selling prices. 

Jump to Issue
To jump to an issue directly from a long list of issues, choose the Edit 
Menu’s Jump to Issue… command (or press and hold the Ctrl key while 

Other Uses for Find

You can Mark, Unmark, and 
Quick Change the issues you’ve 
found. Simply highlight the issues 
in the Found Comics list that you 
want to work with, and choose 
the appropriate commands from 
the Edit menu. This lets you do 
unique operations such as finding 
all Sabretooth appearances and 
marking them as “Wanted”. See the 
chapter on Managing Your Collection 
for more information on using the 
Mark, Unmark, and Quick Change 
commands.



ComicBase Express ComicBase Basics

14

pressing “j”). This will bring  up a small dialog box where you can type in 
the issue number you want to see. 

The jump command is great for finding issues under long-running titles 
such as Action Comics or 2000 A.D. ComicBase Express will take  you 
straight to any issue you want—even if it’s under a different title than the 
one you’re currently viewing! Simply type or scan in the barcode from the 
cover of your comic into the Jump dialogue and ComicBase Express will 
take you to that exact issue. 

And if your comic doesn’t have a barcode? You can also input the 
ComicBase Express barcode number from your comic identification label 
(see Printing and Reports for how to print this barcode) into the Jump to 
Issue dialog box. 

 Tip

Hot Key Shortcuts

Use these buttons on your 
keyboard to navigate your way 
quickly in ComicBase!

Ctrl + F	 Find
  
Ctrl + J	 Jump to Issue
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ComicBase Express

Managing Your  
Collection

Because ComicBase Express comes built-in with information on over 
275,000 issues, it makes tracking your own collection very simple and 
efficient—instead of having to fill in all the details of an issue yourself, 
most of what you’ll be doing is just changing one or two fields in the data 
that is already there. (For instance, changing the quantity in stock from zero 
to one to indicate that you have an issue.)

ComicBase offers a variety of ways to modify issues, depending on your 
particular needs:

•	The Fastest Way to Enter an Issue: To mark that you have one or 
more issues in stock, just highlight them in the Issues List and press 
the 1 key on your keyboard to indicate that you have one copy in 
stock (press 2 to indicate that you have two copies, etc.)

•	Entering Data Directly Into the Issues List: This is useful for mak-
ing quick edits to any field, such as to change a cost or price for an 
issue.

•	Using Quick Change: to set the value of a given field for one or 
more issues (such as to indicate that you paid $1 for issues 312-
338 of Captain America). 

•	Double-Clicking on an Issue: This will bring up the Issue Detail 
dialog where you can change all the information on an issue.

Entering Data Directly Into the Issues list

Most information about an issue can be changed just by double-clicking 
on its field in the Issues List and typing the new information. Here are a few 
tips to make this even easier: 

You can resize the field widths by clicking and dragging their boundary 
line to the desired width. If you don’t want to see a given field, you can 
even drag its width up to nothing, hiding it. (Right-clicking in the column 
in the Issue List header will display these fields again.)

You can change the order in which the Issues List fields are displayed by 
clicking on a field and dragging to the left or right. 

Quick Change

Use the Edit menu’s Quick Change command to quickly modify a single 
field for many selected issues—for instance, if you’d like to quickly change 
the selling price of Spawn issues #1-50 to $3.00. Just select the issues 
you want and choose the Edit menu’s Quick Change command. (You 
can select a discontiguous range of issues by pressing the Ctrl key while 
selecting.) 

 Tip

Enter Issues with Just 
One keystroke!

The quickest way to enter issues 
in ComicBase is to select the  
issues you want and enter a num-
ber between 1-9 to indicate the 
quantity that you own. (Quanti-
ties greater than 9 will have to be 
added by editing the specific cell, 
or by using the Quick Change 
command.) ComicBase will then 
add that value to the Quantity 
field for all the issues selected.

For instance, if you had a copy of 
Amazing Spider-Man #129, you 
could simply select that issue, then 
change its quantity from zero to one 
to indicate that you own it. 
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You can also use Quick Change to modify comics you’ve found using the 
Find Comics command. This is particularly useful if, for instance, you want 
to search the entire database for comics by Neal Adams, then mark them 
as “wanted.” After doing a Find Comics, just select the issues you want to 
change from the Found Comics list, then choose Quick Change from the 
Edit menu.

The Quick Change dialog will appear:

Choose the field you’d like to modify, enter a value, then click Save to 
change that value for all the issues you’ve selected. 

Note that if you use Quick Change to add information in the Notes field 
for a range of issues, ComicBase will append your notes to any information 
that may be in the Notes field already.

You can add a new issue with all the information of the existing issues too. 
This is most useful when you have two copies of the same issue in different 
conditions, or when you’re adding an issue that has mostly (or exactly) the 
same information as a previous issue).

Modifying an Issue’s Detail
If you’d like to see all the information about an issue at once, or perhaps 
want to change several pieces of information about an issue—such as its 
grade, price, notes, etc.—you can simply double-click on the issue, and 
you will be presented with the comic’s Issue Detail dialog. 



Managing Your Collection

17

ComicBase Express

Comic Type

In addition to the regular monthly issues of a comic title, publishers 
sometimes release special comics such as annuals or holiday specials. 
ComicBase lets you enter these by choosing the appropriate comic 
type from the Comic Types dropdown menu. ComicBase lists numerous 
special types of comics, from trade paperbacks to special editions to 3-D 
and ashcan releases, and even swimsuit issues and giant-size specials. 
Moreover, you can add your own comic types to the dropdown menu 
through the Setup menu under Comic Types.

Issue Number 

This is the issue’s number which generally appears on the cover or in the 
tiny fine print on the inside first page (the comic’s “indicia”).

Issue Variations 

It has become an especially popular trend amongst publishers to print 
many variant covers for comics, in particular first issues (check out the 14 
variant covers of Gen 13 #1). If such a case arises, you will want to identify 
the specific variant that you own. 

ComicBase lists most types of issue variations, including variant covers, 
gold, platinum, and silver editions, autographed copies, and more. You can 
add a variation to the variations dropdown menu by going to the Setup 
menu and choosing Issue Variations.

Printings

Some popular comics are re-released in a second printing (or third, fourth, 
etc. These later printings are usually worth less than the first printing. If you 
have a comic that was part of a later printing, the Printing dropdown menu 
on the far right lets you select which printing it was. 

Cover Price

ComicBase will also fill in the cover price based on the previous issue, so 
for example, Wonder Woman (3rd Series) #2 will have the same default 
cover price as #1.

Grading Condition

Select the comic’s condition from the Condition dropdown menu. 
Most undamaged, new comics are in what is known as near mint (NM) 
condition. 

When the condition is changed, ComicBase will automatically update the 
selling price field to match the guide value for this issue.

Grading Wizard

If you’re unsure of the comic’s grade, you can use the ComicBase Grading 
Wizard to help you evaluate the comic. You can access the ComicBase 
Grading Wizard in a couple of ways:

1) Simply click the question mark icon to the right of the Condition 
dropdown and the Grading Wizard will appear. 

2) Or, you can use F8 on your keyboard to bring up the Grading 
Wizard.

Select the appropriate choices that describe your comic’s appearance and 
the Wizard will give you an estimated grade for the comic according to 
accepted industry standards.
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Quantity

The Quantity field lists the number of issues you have of this comic. 

Cost

Type the amount you paid for each comic in the Cost field.

ComicBase will automatically calculate the value for a single copy based 
on its condition in the Selling Price field. If you would like to sell your 
copies for a higher or lower price, you can override the value and type in 
the price you think is appropriate in the Selling Price field. This is the price 
that will appear on price labels and price lists.

If you normally buy your comics at a discount, you can also set a Standard 
Discount for new issues. Click on the dropdown arrow next to cost in the 
Issue Detail dialog to select a discount. ComicBase will remember and 
save this information as the default discount for all new comics entered.

Notes

Enter any special information not handled by the other fields into the Notes 
field. This may include a special character appearance, or reasons for the 
issue’s grade. This information can appear on the issue’s price label and in 
some reports. Use semicolons (;) to separate multiple annotations for the 
same issue, or put each on a separate line in the Notes field. For example, 
if you were adding Asterix Bk 1 and wanted to note that it included the first 
appearances of Asterix and Obelix and gives an explanation of Obelix’s 
strength, you would write “1st appearance Asterix; 1st appearance Obelix; 
Origin Obelix.” 

Storylines

The Storylines field lists the names of the stories that ran in this issue. You 
can add your own entries into this column. This is particularly helpful for 
helping you locate reprinted stories, or for finding the different issues that 
comprise a multipart storyline such as Knightfall. If an issue has multiple 
storylines, put each story on a separate line.

UPC and ISBN

These fields can be used to track your collection using the publisher’s bar 
codes.

Writer and Artist

Use the Writer and Artist fields to enter in the writer and penciller for a 
particular issue. The information you enter here will appear on price labels, 
in price lists, and in writer and artist searches. If you want to list more than 
one writer or artist for a given issue, separate each person’s name with a 
comma (e.g. “Neil Gaiman, Alan Moore.”)

Marking Issues

Sometimes, it’s useful to designate issues that are important to you in some 
way: for instance, comics you have up for auction, or comics which should 
be stored separately due to their high value. Whatever the need, you can 
quickly flag such comics using the Mark and Unmark commands. 

Marked comics appear with a check mark next to them in the Issues View, 
and you can also use the Find Comics command to quickly get a list of any 
marked comics.

To mark one or more issues, select the issues you’d like to modify from 
the Issues View, Modify Issues, or Found Comics list. You can select a 

 Tip

MAKING USE OF THE
GRADING WIZARD

Can’t tell the condition of 
your comic? ComicBase  
Express makes it easy to grade 
your comics with a built-in 
Grading Wizard!

Use F8 to bring up the Grad-
ing Wizard and choose  
what descriptions apply  to 
your comic. ComicBase  
will then automatically  
evaluate the condition and 
even change the selling value 
of your comic to match the 
grade.
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discontiguous range of issues by pressing the Ctrl key while selecting 
issues. Then, choose the Edit menu’s Mark command to mark the issues.

To unmark issues, follow the same procedure to select the issues, then use 
the Edit menu’s Unmark command.

Duplicating an Issue
If you’d like to add a new issue which is a duplicate of an existing one (e.g., 
a second copy of a comic in a different condition), select that issue and 
choose the Edit menu’s Duplicate command. This will bring up the  Issue 
Detail for the duplicate issue. You can change the issue number, condition, 
and any other field just as if you were modifying the original issue.

Adding new issues
As new comics are released, you’ll want to add them to your copy of 
ComicBase. Getting your new comics entered in ComicBase is now easier 
than ever. With your purchase of ComicBase Express, you also get free 
online downloads of all the newest issues and titles every week.

Why spend all that time typing when we’ve already done it all for you? Simply 
go to your Internet menu and use the Check for Updates command, or 
you can tell your ComicBase Express program to automatically check for 
updates by going to the Setup menu and choosing your Preferences.

Of course, you can still add in new issues of your comics by hand. To do 
this, go to the comic title in question and choose the Comic menu’s New 
Issue command (Ctrl + N).

By default, the issue number shown when adding new issues will be the 
next regular issue in the sequence for the selected title. Thus, if you choose 
to add a new issue after Excalibur (2nd Series) #1, published in July 2004, 
ComicBase will add #2 as the next issue, and automatically record it as 
published in August 2004. 

You can set a different issue number by typing in the Number field; if 
you’re adding a range of issues, enter the first issue in the Number field 
and the last issue in the Through field. Any information you enter, such as 
condition, cost, and notes will be entered for all issues in the range.

Removing issues
ComicBase has information on thousands of issues, but as you’ll notice, the 
quantity of each is originally set to 0 (indicating you don’t have any copies 
of the issues in your collection). Most of the time, you’ll want to leave the 
issue information in ComicBase because it’s useful for finding a special 
appearance, artist/writer’s work, or any other issue specifics. Keep in mind 
that you can restrict the list to just titles you own, so that you won’t need to 
remove all issues permanently just to get a report of your collection. 

However, you can also remove issue listings in ComicBase. Simply select 
the issues you want to remove, then right click and choose Delete. You 
can also remove an issue through Issue Detail by clicking on the Remove 
button at the bottom.

NOTE: If you are downloading updates from the ComicBase Express server, 
deleted issues will re-appear in your next ComicBase Express update.

Key Words for use in
The Notes Field

ComicBase looks for certain  key-
words when it searches for special is-
sues. When you add notes with these 
phrases, the entries are automatically 
added to the appropriate list in the 
Find Comics dialog.

Origin or Origin of for origin stories

    Example: Origin Spider-Man

Death or Death of for death stories

    Example: Death of Superman
    
1st appearance or 1st appearance of 

    Example: 1st appearance Dazzler

2nd appearance or 2nd appearance of 

    Example: 2nd appearance Cable

Appearance for special appearances
 
    Example: Lobo appearance
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Adding New Titles
If you happen to own a title which is not already listed in ComicBase, you 
may want to add in the title yourself.

Naming Titles

Be aware that the proper title is not always the same as the name on 
the cover—in fact, it can be fiendishly difficult to determine the proper 
name for a title. ComicBase lists titles by what is called the “indicia” 
of a comic. The indicia is the paragraph containing the copyright and  
publication information of a comic, usually located on the inside front or 
back cover of a comic.

If a title begins with “The” or “A” or “An” put any one of that word at the 
end of the title, separated by a comma. For instance, if you were adding 
The Vigilante, you would enter it as “Vigilante, The” in the Name field. 
This way, ComicBase will list the title in alphabetical order under “V” 
(Vigilante) rather than “T” (The). If the title contains both an article and a 
colon, such as The Trouble With Girls: The Night of the Lizard, then move 
the article right before the colon and write the rest as it appears. Thus, the 
correct name is: “Trouble With Girls, The: The Night of the Lizard.”

Publisher

Next, select the title’s publisher from the Publisher dropdown menu. If 
the publisher’s name doesn’t appear on the list, type in the name of the 
publisher and press Enter. A dropdown will appear that will allow you 
to enter in the publisher’s information. If you have a lot of titles from a 
particular publisher not in the Publisher menu, you may wish to add the 
publisher to your list of publishers so that it appears the next time you add 
a title. Otherwise, uncheck the  Add to List of Publishers box at the bottom 
of the dropdown.
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Copyright

You can type in the copyright information in the Copyright field. Usually, 
you’ll find this information in the indicia of a title. 

Years Published

The following line asks for the years a title was published in the Years 
Published field. This information will appear in the Title Description 
window. When adding years, separate year ranges with commas or 
hyphens to differentiate between different publishing years and consecutive 
publication years. E.g.  “1979, 1985” or “1983-1988, 1999-Present” 

Title URL and Comments

ComicBase also provides spaces for adding title URL, title comments, and 
checkboxes for genre identifiers, which you can customize to add your 
own. If you enter a title URL here, the user can go directly to that title’s web 
page by clicking on the title name. 

You can enter title comments in the Title Comments field. ComicBase 
occasionally uses this field to note a publisher name change during a 
series’ run, but you can use it to keep any notes you wish.

Mature Titles

The Mature Readers Only box is for titles which deal with themes you 
believe are not appropriate for younger readers. Any title with this box 
checked will be removed if you go into the File menu’s File Tools and 
choose Remove Mature Readers Titles. 

Marking Titles

The Comic Title dialog also lets you mark a title so that you can find it easily. 
Marking a title in ComicBase Express does not add it to your inventory. 

Genre

Below the Title Comments field is a number of checkboxes to denote 
the genres this title belongs to. For instance, if you were adding a title 
about some zany astronaut rabbits, you might check “Anthropomorphic,” 
“Comedy,” and “Science Fiction.” (See the ComicBase Genre Definitions 
on the next page for a full list.) 

Icons for the checked genres will appear in the Title Description window. 
You can also go to the Setup menu and use the Custom Fields command 
to add your own genres. You can also search for titles by their genres, 
including custom genres. 

Modifying Titles
To modify titles in ComicBase, open the Title List, highlight the title you 
wish to change, and click the Modify button at the bottom of the list. This 
will bring up the Title Detail box where you can modify the information 
for that entry.  

Editing title Descriptions
The space below the picture box will generally contain a review for the 
series you are viewing. We’ve worked hard with the guys over at Comic 
Buyers Guide to bring you the most comprehensive encyclopedia of comics 
reviews available to date. But if you find any entry with no review, or you 
wish to add to the review, you can easily change the text by going to the 
Comics menu and choosing Edit Title Description. Or, you can submit 
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your own, credited description to Comicbase by clicking on the link. This 
will ensure that all future editions of ComicBase will have a description 
for the title. 

When a Done Editing button appears above the text field, you can begin 
editing the description or add in a new one. If your description is too large 
for the description box, ComicBase will automatically add a scroll bar that 
lets you scroll through the description. Click Done Editing to stop editing. 

Bold, Italics, and underlining

The Style and Font menus on the main menu bar are only activated when 
you use the Edit Title Descriptions command.

You can make words in your title description appear bold, italicized, 
underlined, or as hypertext by making use of the Style commands from 
the main menu bar. Highlight the text you wish changed and select the 
command you want from the menu. 

You can also change the font size of the description by using the Style 
menu bar. You can alter the type of font displayed by going to the Font 
menu and selecting the font you want to use.

Creating Hypertext Links 

ComicBase lets you link words in your description to other titles through 
a Hypertext command. To do so, highlight the name of the other title in 
your description and choose Hypertext from the Style menu. The selected 
text will be changed to blue. Now, whenever you click the highlighted 
words, ComicBase will jump to the next sequential title beginning with 
those words.

Removing Titles

Removing a title from ComicBase Express removes all of its information. 
If you only want to restrict a list to only the titles you own, it’s safer just to 
click the Titles in Stock button in the Titles list.

To remove titles from your collection, first open the Title List, and in the 
dialog box that appears, select the title you want to remove. Then, click 
Remove. 

NOTE: If you are downloading updates from the ComicBase Express server, 
deleted titles will re-appear in your next ComicBase Express update.

Managing More Than One 
Collection
You and your son/friend/roommate/boyfriend/girlfriend can now keep 
your collections separate in ComicBase Express. To do this, choose the 
File menu’s New Database command and create a new file. You can then 
switch between the different databases by using the File menu’s Open 
Database command.

It’s also a good idea to choose different colored backgrounds to keep track 
of your separate collections. You can change the color of a databases main 
window by using the File menu’s Window Color command.

Backing Up Your Copy of ComicBase
Since your ComicBase Express contains important information about your 
collection, we recommend keeping at least one backup copy of your data. 
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This will preserve the work you’ve done should anything (such as a crash 
while writing to disk) corrupt your active copy of ComicBase Express. 

By default, ComicBase Express will keep a backup copy in the ComicBase 
Express folder on your hard drive. If you want to keep your backup in 
another location, go to your Setup menu, and under Preferences, choose 
“Save all backups to folder” and specify where you want your back-up 
copy stored. 

To protect your data in case of hard drive failure, we also recommend 
periodically transferring a copy of your database onto a CD or DVD, or 
creating a backup copy on a remote hard drive or removable media. 

To do so, select the File menu’s Save a Copy command. You can save your 
ComicBase onto any hard drive or onto removable media. The file will be 
called “Copy of ComicBase.cba”

If you only have a floppy disk, you can back up your data only by using 
the File menu’s Export Price List command. (The ComicBase database is 
too large to fit on a floppy disk.) This will export only the issue information 
you’ve entered, which will fit on a floppy disk as a text file. This backup, 
however, will not include information such as: covers you’ve scanned in, 
descriptions you’ve modified, or custom grading and other custom fields.

Checking for Program and  
Price Updates
ComicBase Express comes with twelve months of free price and title 
updates. We also occasionally release minor bug fixes and enhancements 
to the program. To get these, use the Internet menu’s Check for Updates 
command.

You can also set the program to check for updates every time the program 
launches, once a day, once a week, once a month, or never. Go under the 
Setup menu and select Preferences, then identify the frequency you’d 
like the program to check for updates. If you don’t have internet access, or 
prefer to check for updates manually, select Never.
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Printing and Reports

ComicBase Express can generate a variety of reports and labels, including 
price lists, price labels, and inventory reports for managing your collection. 
This chapter describes the various statistics and labels you will be able to 
print. You can see a preview of any report before you print it by clicking the 
Preview button in ComicBase’s Print dialog. 

ComicBase Statistics
You can ask ComicBase Express to report different kinds of information 
about your collection, such as:

• The cost and value of your collection

• The number of titles and comics you own

• The date of your last ComicBase update

• The date that your online pricing subscription will expire

To view statistics about your collection, go to the File menu, select 
ComicBase Statistics, and click the Calculate button. ComicBase will 
automatically tally the number of comics you own along with the total 
value of your collection when you do this. The report will list how many 
titles and comics you own as well as present the cost, value, and asking 
price of your collection all sub-totaled by publisher. 
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 To see the specific titles that you own, highlight a publisher and click on 
the List Titles button. ComicBase will then generate a second report of all 
the titles you own under that publisher. If you’d like to see more details 
about titles with missing descriptions or pictures, choose the More button 
at the bottom of the Statistics dialog. Checking the Titles With Missing 
Descriptions or Titles With Missing Pictures box will let you know if (and 
how many) titles you have missing descriptions and pictures, respectively. 
These checks considerably lengthen the time for the Statistics Report to 
process, as they require the program to check every title in ComicBase. 

Once the statistics have been calculated, you can preview the printout by 
pressing the Preview button, or print the statistics by directly by clicking 
Print.

You can also download program and pricing updates or renew your 
ComicBase Express subscription by clicking on the corresponding buttons 
in the ComicBase Statistics dialog.

Printing Price labels
You can use ComicBase to create price labels for each of your comics, or 
just for comics you own from specific titles. Each price label will show the 
comic’s title and issue number, condition, price, and notes. The label will 
also show writer and artist credits unless you uncheck those listings in the 
Issue Listings box in Preferences (found under the Setup menu).

ComicBase can print to a variety of label types and sizes, including popular 
Avery labels and standard-sized labels from Dymo. The labels include a 
code that tells you when the label was printed. The first number in the code 
indicates the month the issue was entered into inventory (i.e. 5 for May), 
followed by an X, the day of the month the label was printed (i.e. 31 for 
the 31st day), and the last digit of the year the label was printed (i.e. 7 for 
1997).

To print price labels for your comics, follow these steps:

1.	 Go to the Report menu and select the Price Labels command. 
You can also reach this dialog through the File menu by choosing 
Print and selecting the Price Labels icon from the top bar of the 
dialog box.
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2.	 Select the type of price label you are going to use from the 
Label dropdown menu. ComicBase will automatically resize 
the price label text to fit the label size you select.           

3.	 Select the titles and issues you want to print labels for.

a.	 To print price labels for all the comics in your collection, 
click the All radio button.

b. 	To print price labels for all the comics you own, but only 
for certain titles, click the Selected Titles radio button. A 
dialog box will appear which lists the titles in ComicBase 
Express. Select the titles for which you want price labels 
printed. Hold down Ctrl to select more than one title. 
(Moving between parts of the list will not deselect your 
selections).

c.	 To print price labels for specific issues, click the Selected 
Issues radio button. The Issue Selection dialog box will 
appear. Click Add to select a title, then select issues from 
that title for which you want labels printed.

	 If you want to add issues from another title to the list, click 
Add in the Issue Selection dialog box. Continue adding 
issues, title by title, until you have a complete list of the 
specific issues for which you want price labels. If you 
accidentally select an issue or issues for which you don’t 
want labels, select the issues and choose Remove.

	 By default, ComicBase will assume you want to print 
a price label for each comic of an issue you own. For 
instance, if you own two copies of Spawn #11, ComicBase 
will print a label for each copy. If you want to change the 
number of labels per issue that ComicBase prints, select the 
issue (or issues) in the Issue Selection dialog box and click 
Copies. Change the number in the box that appears to the 
number of price labels you would like ComicBase to print, 
then click OK.

4. 	You can check the Only Print If New or Price Changed box 
print labels only for comics that have been added recently, or 
have had their price change recently. This feature is especially 
useful if you regularly print price labels for your comics.

5. 	If you’d like the labels to include storylines, check the Include 
Storylines checkbox.

6. 	In the Print dialog box, select the first available label on your 
first sheet of labels.

7. Click the Print button to start printing labels.
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Printing Comic Identification Labels
You may also want to print labels without the pricing to help you identify a 
particular issue of a series. You can print identification labels with a picture 
of the comic for your by going into the Report menu and selecting Comic 
Identification Labels. You can also right click on the issue in the issue 
field print a label for that comic.

To have include a ComicBase Express bar code with your identification 
label, check the Include  bar code box. You can use this barcode to quickly 
Jump to a specific issue from any other title in the database.

Printing Price Lists
ComicBase can print price lists showing the issues in your collection. These 
reports are particularly useful for creating a list of comics for sale.

To create a price list:

1.	 Go to the Report menu and choose Price List. Or, you can go 
to the File menu and select Print to bring up the same printing 
and reports dialog. 

2.	 If you want the report to include only comics you own, check 
off the box marked List Only Issues in Stock. If you want the 
report to include information on the issues’ storylines, check 
off the box marked Include Storylines. If you want your reports 
to show your cost as well as the issues’ value, check the box 
marked Include Cost.
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3. 	If you want a price list for all the comics in ComicBase, make 
sure the All radio button is filled in. Check the List only issues in 
stock checkbox to limit the list to comics you own. Otherwise, 
you will end up with a report that runs for thousands of pages.

4. 	If you want a price list for only one title, or only for selected 
titles, click the radio button next to Selected Titles. A list of all 
the titles in ComicBase will appear. You can narrow the list to 
just the titles you own by clicking Titles in Stock. 

	 Select the titles you want included in the report. Use the arrows 
at the lower left hand corner to view the first, second, and third 
part of this list. Hold down the Ctrl key to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK when you’ve selected all the titles you 
want to include.

	 You can also create a selection that’s the result of a search by 
clicking the Find button. 

5. 	Choose between Basic, Summary, or Detailed radio boxes in 
the Report Type box.

	 Basic price list shows you the number of copies you own of an 
issue and each comic’s condition, value, and/or cost. This list 
totals the value of your collection by title.

	 Summary price list shows the value and number of copies of 
each title in your collection, and, if you’re including it, cost.

	 Detailed price list shows the number of copies you own of an 
issue and each comic’s condition and value, and, if you’re 
including it, cost. This report is generally printed in landscape 
(wide) orientation.

7. Click the Print button to print your price list.
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Printing Issue Checklists
ComicBase lets you print issue checklists that show you the issues you own 
and/or the issues you want, their near-mint value, and notes about them. 
For issues you own, it will also tell you how many copies you have, what 
condition the copies are in, their value, and how much you paid for each 
copy. These reports are particularly useful for taking to a convention or 
store to effectively build the collection you want.

To create an issue checklist:

1.	 From the Report menu, select the Issue Checklists. (You can 
also go to the File menu, go to Print, and click on the Issue 
Checklists icon to open the same dialog.)	

2.	 Check off what you’d like the report to include in the Report 
Items box. If you check Issues of each title, the report will list 
all the issues you own. If you check Missing Issues for each title, 
the report will list issues you don’t own.

3.	 To include every title in ComicBase, check the All radio button. 
To create a report that only includes a title, or certain titles, 
click the Selected Titles radio button. 

	 You can also create a selection that’s the result of a search by 
clicking Find while selecting titles. 

	 You can also narrow the list to just the titles you own by clicking 
Titles in Stock. Hold down the Ctrl key  to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK” when you’ve selected all the titles you 
want to include.

4. 	Check Include Storylines to include storylines along with the 
report information.

5. Click the Print button to print your Issue Checklists report.

Finally, to print an issue checklist only for the title you are currently viewing, 
right click over the title’s name in the main window and select the Print 
Issue Checklist command.
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Printing Title Reports
You can use ComicBase Express’s title reports to create a hard-copy record 
of the comics you own and their total worth. Title reports are the most 
compact way to show what you have in your collection.

To print title reports:

1.  Choose Title Report from the Report menu. Or, go to the File 
menu to select the Print command and click on the Title 
Report icon in the dialog box to select it 

2. Check off what you’d like the report to include in the Report 
Items box. If you check Issues of each title, the report will list all 
the issues of all the titles you’re including. If you check Missing 
Issues, the report will list issues you don’t own.

3. 	To include every title in ComicBase, check the All radio button. 
To create a report that only includes a title, or certain titles, 
click the Selected Titles radio button. 

	 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. 

   	 Narrow the list to just the titles you own by clicking Titles 
in Stock. Hold down the Ctrl key  to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK when you’ve selected all the titles you 
want to include.

4. Title reports, by default, will list each issue individually, so you 
can mark them off. If you prefer a shorter report, you can list a 
contiguous range of issues as a group (e.g. Action Comics #488-
490, 493-497, 501) by checking the Group Issue Numbers 
Together box.

5. Click the Print button to print your Title report.
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Printing Divider Labels
If you have an extensive collection, you may be using dividers to separate 
your titles. These dividers are available from most comic book dealers.

With ComicBase, you can print labels for the tabs on your dividers. 

To print divider labels:

1.	 Choose Divider Labels from the Report menu, or go to the File 
menu and choose Print. (You can also shortcut this process by 
right clicking over the title name and choosing Print Divider 
Labels for this Title. This third option will let you print divider 
labels only for the title you are looking at. Skip to Step 5 if you 
choose this option.)

2.	 Click the Divider Labels icon to select it.

3.	 If the All radio button is filled, ComicBase will print divider 
labels for all the titles in ComicBase.

4. 	To print divider labels for only certain titles, click the Selected 
Titles radio button. A list of all the titles in ComicBase will 
appear. 

	 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. 

	 You can also narrow the list to just the titles you own by clicking 
Titles in Stock. Hold down the Ctrl key while clicking to select 
more than one title. (Moving between parts of the list will not 
deselect your selections). Click OK when you’ve selected all 
the titles you want to include. 

5. 	Use the Label Type dropdown menu to select the label size 
on which you’ll be printing your labels. ComicBase will also 
automatically size the text to fit your label.

6. 	Click the Print Labels for Both Sides box if you want to print two 
labels for each title—one label for each side of the divider.

7. 	Click on the position of the first available label on the first label 
sheet, and click the Print button to start printing.
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Printing Divider Descriptions
You can print the descriptions for each title onto labels that you can affix to 
your title dividers. This is very helpful for prospective buyers who want to 
learn more about the titles in your collection before a purchase.

To print divider blurbs

1. 	Go to Divider Blurbs in the Report menu. Or, choose Print 
from the File menu. (Click the Divider Blurbs icon to select it.) 

3. 	If the All radio button is filled, ComicBase will print divider 
blurbs for all the titles in ComicBase.

4. 	To print divider blurbs for only titles you own, or only for certain 
titles, click the Selected Titles radio button. A list of all the titles 
you own in ComicBase will appear. 

	 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. (See page 12).

	 You can also narrow the list to just the titles you own by clicking 
the Titles in Stock button. Hold down the Ctrl key while 
clicking to select more than one title. (Moving between parts of 
the list will not deselect your selections). Click OK when you’ve 
selected all the titles you want to include). 

5. 	Use the Label dropdown menu to select the label size on which 
you’ll be printing your labels. ComicBase will shrink the font 
size down to fit the description on any size label.

6. 	Check the Print Labels for Both Sides box if you want to print 
two blurbs for each title—one description for each side of the 
divider.

7. 	Click on the position of the first available label on the first label 
sheet, and click the Print button to start printing.
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Importing Data

ComicBase Express includes functions for importing data to help you 
manage your collection. The import function lets you transfer data from 
most major spreadsheets and databases, such as FileMaker or Microsoft 
Excel.

Importing Information  
from Other Programs
You can use the File menu’s Import Price List command to import 
information from another program, such as a database or spreadsheet:

1. 	Export your information from the database or spreadsheet 
to a tab-delimited text file. If you’re not sure how to export 
information from the database or spreadsheet, review your 
documentation for that program. You will need to export 
information for at least four fields: title, issue number, condition, 
and quantity. 

2. From the File menu, select Import. In the dialog box that appears, 
locate the exported file on your hard disk.

3. 	When you click Open, the Import Price List dialog box will 
appear.

4. 	Move fields that match your exported files to the Import Fields 
box using Move. For instance, if you have fields for title, 
issue number, condition, cost, and value in your database or 
spreadsheet, you would move the fields Comic Title, Issue 
Number, Condition, Cost, and Selling Price.

5. 	Use the dropdown menus to select how items and records are 
separated (by tab, return, or space) in the exported file.

6. 	The order of fields in the Import Fields dialog box should match 
the order of fields in your database or spreadsheet. 

7. 	Radio buttons at the bottom of the Import Price List dialog box 
let you choose how you want your information to integrate with 
the information already in ComicBase.

	 Replace All Issues of Imported Titles is faster, but it will overwrite 
all issue information in ComicBase. Only use this option if you 
want to replace all the information in ComicBase.

	 The more common option, Replace Only Matching or New 
Issues is slower, but it will only overwrite the issues being 
imported. 



Importing and Exporting

34

ComicBase Express

8.	 Some spreadsheet or database programs create an initial “mail 
merge” header that lists the names of the fields. This can be 
useful if you want to match up ComicBase fields with the fields 
you’re using, but if you try to import the header, you will get an 
error message in ComicBase telling you something like there 
is no title named Comic Title. You can skip past the header by 
typing in how many Lines to Skip at Beginning.

9. 	Click Show Preview to see how your fields will match up with 
ComicBase fields. Always use Show Preview to make sure 
your data will be imported into the correct field. Most of the 
problems with importing are the result of importing data into 
the wrong fields.

10. After importing your information into ComicBase, look at the 
Issue View and the Issue Detail for the titles for which you’ve 
imported information, and check that your information has 
been imported into the right fields.

NOTE: You can also drag and drop any text file into the current version of 
ComicBase Express to prompt the program to bring up the Import dialog. 
Select the fields you would like to import and continue from step 4.
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Advanced ComicBase

Modifying Issue variations
The Variations dropdown menu in the Issue Detail is set up for most types 
of issue variations, including gold, platinum, and silver editions, special 
covers, special sets and editions, such as a collector’s set or a deluxe 
edition. You can also use it to specify an issue you’ve had autographed. 

The following will show you how to add, change, or remove items from the 
list of issue variations.

Adding an issue variation

1.	 Under the Setup menu, select Issue Variations.

2.	 In the Issue Variations Setup box, click New.

3.	 Type the name of the new issue variation into the Issue Variation 
field.

4.	 Move to the Abbreviation field and type in an abbreviation, up 
to four characters long, for the issue variation. This will appear 
next to the issue number in the Issues dialog.

5.	 Click Save to save the new issue variation. It will be available in 
the Variation dropdown menu in the Issue Detail dialog.

To change the name or abbreviation for an issue variation, select it in 
the list and change the name or abbreviation in the Issue Variation and 
Abbreviation text boxes. Click Save. The new name and/or abbreviation 
will appear in the Variations dropdown menu, but will not change the 
previous abbreviation used for comics already indexed in ComicBase 
Express.
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Modifying Comic types
The Comic Types dropdown menu lets you specify if you have a special 
comic such as a 3-D special, annual, ashcan preview, or yearbook. You 
can add, remove, or change these comic types.

Add a new comic type

1.	 Go to the Setup menu and select Comic Types.

2.	 In the Comic Types Setup box, click New. Type the name of the 
new comic type in the Comic Type field.

3.	 In the Abbreviation field, enter a 2- or 3-letter abbreviation for 
the comic type. This abbreviation will appear next to the issue 
number in the title’s Issues Field.

4.	 Click Save to save the new comic type. You will now be able 
to select it in the Comic Types dropdown menu in the Issue 
Detail.

Remove a comic type

1.	 Go to the Setup menu and select Comic Types.

2.	 Select the comic type you want to remove and click the 
Remove.

3.	 Click Save to save the changes. The comic type you removed 
will no longer be available in the Comic Types dropdown menu 
in the Issue Detail.

To change the name or abbreviation for a comic type, select it in the list 
and change the name or abbreviation in the Comic Type and Abbreviation 
fields. Click Save. The new name and/or abbreviation will appear in the 
Comic Types dropdown menu and the Issues Views, but will not change 
the previous abbreviation used for comics already indexed in ComicBase.
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Modifying Publishers
The Publishers dropdown menu in the Issue Detail dialog lets you choose 
from the most common publishers. If your publisher is not in the list, type 
in the name of that publisher anyway, and when you move to edit another 
field in the Issue Detail dialog, a dropdown menu will appear asking you 
for the publisher’s information. If you have a lot of comics from a publisher 
not in the Publishers dropdown list, you may wish to add that publisher to 
the Publisher dropdown menu. Just check the Add to List of Publishers box 
at the bottom of the dialog.

Another way to add a publisher is to select the Setup menu’s Publishers 
command. 

Type the name of the publisher into the Publisher Name box. ComicBase 
automatically enters the publisher’s name into the Copyright field. If a person 
or company other than the title’s publisher typically owns the copyright to 
the title you’re adding, type in the name of the proper copyright holder. 
This is the information that will appear in the copyright title whenever you 
add a title from this publisher.

If you know it, enter the publisher’s web site address (URL) into the 
Publisher’s Home Page box.

Click Save to add the publisher to ComicBase and exit the dialog. The 
publisher you’ve added will now appear in all Publisher dropdown menus 
in ComicBase.

To change a publisher’s information, select the Setup menu’s Publishers 
command, and select the publisher whose information you want to change. 
You can overwrite or add information, such as web site address, to the 
publisher’s fields. Click Save to save your changes.

To remove a publisher, select the Setup menu’s Publisher command. 
In the dropdown menu, select the publisher you want to remove. Click 
Remove. The publisher you removed will no longer be available from 
Publisher dropdown menus in ComicBase.

Note: removing a publisher from the Publishers dropdown menu will not 
remove that publisher’s titles from ComicBase. It will only remove the 
publisher name from the Publisher dropdown menus.
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Using Find and Replace
ComicBase Express includes the ability to Find and Replace text information 
across the entire database. This works like the Find and Replace function in 
a word processor, and is particularly useful when you want to standardize 
the spelling of artist names, change the names of publishers, or even change 
the spelling of condition names (e.g. changing NrMt to NM). 

To find an replace text, go to the Edit menu and choose Find and Replace. 
Enter the text you’d like to search for, and choose which field to look in.  
Keep in mind that since Find and Replace works only on text information, 
it cannot search date or check box fields. 

File Tools
Under the File menu is a command for File Tools, which gives you access 
to a variety of tools for streamlining ComicBase, making it run faster, 
converting ComicBase’s values to your local currency, and fixing minor 
program problems.

Compact and Verify ComicBase

Compacting ComicBase will prompt the program to verify the integrity 
of the database and free up any unused space. You can set the conditions 
for how frequently ComicBase will compact its information by selecting 
the option you want in Preferences. To start this operation yourself, go 
to the File menu, and under File Tools, choose Compact and Verify 
ComicBase.

Rebuild Lists

Like most databases, ComicBase does not physically reconstruct itself each 
time a record is changed. Instead, it marks the old information as unused. 
This unused space can build up over time, and take up unnecessary 
space on your hard disk. Compacting ComicBase frees unused space in 
ComicBase and verifies the integrity of your data.

When you click the Compact & Verify ComicBase button, you will get 
a dialog box that tells you how much space you’ll save if you compact 
ComicBase. Click the OK button to start compacting. The process may take 
several minutes.

The Rebuild Lists button rebuilds lists and indices in ComicBase. ComicBase 
checks to make sure its list of titles is correctly matched with the pictures 
and data from each. If you find that ComicBase is not matching pictures or 
data correctly to titles, this command will rebuild the list of titles in stock, 
the Find comics lists, issue information, and title names and descriptions.
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When you click the Rebuild Lists button, the following dialog will appear:

Checking Title Information rebuilds ComicBase’s internal title and 
descriptions index. It’s useful if ComicBase isn’t taking you to the title you’ve 
selected—i.e. you entered “Abe Sapien” in the Title List and ComicBase 
took you to 2000 A.D. instead.

Checking List of Titles in Stock will rebuild the list of titles you own. This 
is particularly useful if you’ve added titles, but they’re not appearing when 
you click the Titles in Stock.

Checking Issue Information will rebuild values within ComicBase, and 
is particularly helpful if you believe ComicBase may be totalling values 
incorrectly. Rebuilding issue information will also check through your notes, 
storylines, writer, and artist lists and will remove any duplicate or near-
duplicate information (e.g. a note reading “1st appearance of Punisher; 1st 
appearance of The Punisher”). In discarding duplicates, in this manner, the 
longest item will be preserved. In the example above, the note would be 
changed to “1st appearance of The Punisher”. This option also standardizes 
the spellings of thousands of known creator names.

Checking Find Comics Lists will rebuild the Find Comics lists which appear 
after you’ve used the Find command to find character appearances, work 
by a writer, or other comic book related information. If the lists that are 
appearing are inaccurate, check off this box.

Reset ComicBase Settings

If at any time you want to reset the your preferences in ComicBase, simply go 
to File Tools and click on Reset ComicBase Preferences. This command 
is useful for returning ComicBase to its “factory settings.” If you’ve added 
grades, publishers, issue variations, or made other special modifications 
to ComicBase, it will remove them and replace them with the original 
settings. However, it will not remove any collection data, such as issues 
owned, from your copy of ComicBase.

Currency Conversion

The Convert Currencies button converts the values in ComicBase, which 
are in U.S. dollars, to your local currency values.

You’ll need to know the current exchange rate from U.S. dollars to your 
local currency. When you click the button, a dialog like the following 
appears. 

Type in how much 1 U.S. dollar would be worth in your currency (i.e. 1.5 
Canadian dollars, .68 UK pounds) and click OK to convert the values.
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Remove Mature Reader Titles

ComicBase covers the entire world of comics, including a number of titles 
designated for mature readers only. These may have been classified as such 
due to sexual content, graphic violence, and/or depictions of drug use

If you don’t want to view such titles—or don’t want the person who 
will be using ComicBase to view such titles, you can remove them from 
ComicBase. To do this, select the File menu and go to File Tools. In the 
box that appears, click Remove Mature Titles.

Once removed, a title can only be restored by reinstalling ComicBase or by 
manually adding the title back into the database.
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Troubleshooting

Although we hope your experience with ComicBase Express is blemish-
free, we have added this section to answer frequently-asked questions, let 
you know how to resolve problems yourself, and give you tips on getting 
the best technical support from us.

Frequently Asked Questions
This list covers our most frequently-asked support and technical 
questions. You can find more frequently-asked questions online at  
http://www.comicbase.com/Support/FAQ.asp

Q:	Why don’t you have (my favorite title) in ComicBase?
A:	 Hey! We’re trying! But seriously, there are a few major reasons why a 

particular title may not be covered: 1) the title came out too recently 
to make it into the latest edition, 2) the title is old and/or rare and 
therefore difficult for us to obtain for coverage, or 3) the title is still 
in the process of being reviewed, indexed, historically priced, and 
scanned, or 4) the title may be indexed under another name, such as 
Four Color Comics.

    	
	 If you find ComicBase doesn’t have a title you collect, use the New 

Title command to add titles from your collection into ComicBase. 
If the title appears in the next ComicBase update, you can easily 
integrate any information you’ve added into the update process.

Q:	Where are the rest of the X-Men (or Justice Leagues, or…)?
A:	 Marvel’s X-Men are listed as X-Men (1st series) until issue #142, 

after which they went through a little-noticed name change to 
become officially The Uncanny X-Men (where subsequent issues are 
listed). Justice League America/International/Europe went through 
numerous such mid-title name changes, and issues are listed under 
the appropriate titles (although the shifts still make us dizzy). We 
generally try to smooth such transitions by noting where series are 
continued in the notes of the last issue of the original run, as well 
as where they are continued from in the first issue of the renamed 
series.

Q:	Windows keeps telling me there isn’t enough space to install 
ComicBase.

A:	 Windows requires two to three times the amount of your RAM as 
“swap space” on your hard drive, generally the C: drive. Also the C: 
drive is used to decompress files. Even if you’re installing onto a drive 
other than the C: drive, your C: drive will need about 200MB of free 
disk space. You cannot install ComicBase to your A: or B: drives.

Information Online

Minor updates and bug fixes 
to the current version of Com-
icBase are free online at  
h t t p : / / w w w. c o m i c b a s e . c o m / 
Support/Updaters/ComicBase_Up-
dates.asp

A complete list of all the titles in the 
current version of ComicBase, re-
ports of incompatibilities, and other 
troubleshooting tips are available at  
h t t p : / / w w w. c o m i c b a s e . c o m / 
Support/Technotes/technotes.asp

News and information on 
ComicBase can be found at  
http://www.comicbase.com
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Q:	I can’t save a backup copy of ComicBase.
 A:	You need to make sure you have enough space for a backup. You can 

specify where you want ComicBase to save its backup by clicking the 
Change Location button in the Preferences dialog box.

 
For More Help
A few simple steps can clear up many common problems. Here are a few 
suggestions if you’re experiencing trouble with ComicBase Express:

1. 	ComicBase Express is so much fun, you probably installed it 
and got going right away. If you are having trouble figuring out 
how to use a certain feature, or how to use it more efficiently,  
chances are, that feature is already covered in this User Guide.

2. 	Read the “Read Me” file on the ComicBase Express disk. This 
details known incompatibilities and other known problems 
which may have come to our attention after this manual was 
written.

3. 	If you have access to the internet, use the Internet menu’s 
Check for Program Updates command, or go to our website, 
http://www.comicbase.com, for more recent updates or 
incompatibilities. If necessary, download the latest update.

4. 	Use File Tools to compact ComicBase, rebuild the title list, or 
reset program settings. Information on these features is covered 
in the Advanced ComicBase section.

5. 	Try to recreate the problem. This way, you can tell technical 
support exactly how the problem occurred. Write down any 
error messages that appear.

Before you contact technical support, make sure you have the following 
information ready:

•   Which version of ComicBase you have (i.e. version 10.0.1)
•   The operating system you’re running (i.e. Windows 2000 or Windows 

XP) and how much memory (RAM) your computer has. If you don’t 
know, right-click on My Computer and choose Properties to find 
out.

•  Be sure that you’ve already registered your copy of ComicBase Express 
Include your serial number with your technical support e-mail. You can 
find your serial number on the inside of the case of your ComicBase 
Express program. You can also find it on your registration card.

You can reach technical support at support@human-computing.com. 
Include your name and serial number along with a detailed description 
of what kind of problem you’re having with your ComicBase Express 
program.



Keyboard Shortcuts

Ctrl + A Select all

Ctrl + B Buy a comic

Ctrl + C Copy

Ctrl + D Duplicate the selected issue

Ctrl + E Edit title description

Ctrl + F Find comics

Ctrl + G Quick change the selected issues

Ctrl + H Hypertext (used when editing descriptions)
Ctrl + I Add issues to inventory

Ctrl + Shift + I Modify issues for the current title

Ctrl + J Jump to issue

Ctrl + L New title

Ctrl + M Mass change

Ctrl + N New issue

Ctrl + P Print reports and labels

Ctrl + Q Quit comicBase

Ctrl + R Mark the selected issues

Ctrl + T Open title menu

Ctrl + Shift + T Modify the current title

Ctrl + U Unmark titles

Ctrl + V Paste

Ctrl + X Cut

Ctrl + Z Undo

Ctrl + [ Previous title

Ctrl + ] Next title

Shift + Click on Next Title or Previous Title button Go to the next or previous title with no picture. 

Alt + Shift + Click on Next Title button Go to the next title with no issues

Alt + Shift + Click on Previous Title button Go to the next title with no title description

Click (on the publisher name on the Pictures View) Go to that publisher’s web site. (Publisher name will show as colored 
text if a web site is defined for that publisher)

Alt-Click  (on a cover picture in the Pictures View) Open the selected picture in Windows Explorer

Alt-Click (on the publisher name in Pictures View) Open the publisher picture folder on your hard disk or CD
F12 ComicBase Statistics

F8 Grading Wizard

One-Key Issue Entry

(Available from the Issue Field and Modify Issues dialog)

0-9 Sets the quantity for the highlighted issues to that number

[Enter] Go to the Issue Detail for the selected issues

+ Add 1 to the selected issues’ quantity

- Subtract 1 from the selected issues’ quantity


